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          Adobe Acrobat Reader  
 

Finding Words 
 

You can use the Find command to find a complete word or part of a word in the current PDF 

document.  Acrobat Reader looks for the word by reading every word on every page in the file, 

including text in form fields. 
 

To find a word using the Find command: 
 

1. Click the Find button (Binoculars), or choose Edit > Find. 

2. Enter the text to find in the text box. 

3. Select search options if necessary: 

Match Whole Word Only finds only occurrences of the complete word you enter in 

the box.  For example, if you search for the word stick, the words tick and sticky will 

not be highlighted. 

 

Match Case finds only words that contain exactly the same capitalization you enter in 

the box. 

 

Find Backwards starts the search from the current page and goes backwards through 

the document. 

4. Click Find.  Acrobat Reader finds the next occurrence of the word. 

        

To find the next occurrence of the word, Do one of the following: 

            

            Choose Edit > Find Again  

            Reopen the find dialog box, and click Find Again.  

            (The word must already be in the Find text box.) 

 

Copying and pasting text and graphics to another application 
 

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 

into another application such as a word processor.  You can also paste text into a PDF 

document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 

can switch to another application and paste it into another document.   

 

Note:  If a font copied from a PDF document is not available on the system displaying the 

copied text, the font cannot be preserved.  A default font  is substituted. 
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To select and copy it to the clipboard: 

1. Select the text tool T, and do one of the following: 

       To select a line of text, select the first letter of the sentence or phrase and drag to 

       the last letter.   

 

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 

(Mac OS) as you drag across the width of the document.  

        

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 

(Mac OS) as you drag the length of the document. 

         

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 

on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 

in the document is selected.  When you release the mouse button, the selected text is 

highlighted.  To deselect the text and start over, click anywhere outside the selected text.   

The Select All command will not select all the text in the document.  A workaround for this 

(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 

text to the clipboard. 

 

2. To view the text, choose Window > Show Clipboard 

 

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 

Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 

Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 

Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK. 
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METROPOLITAN TRANSPORTATION COMMISSION JOINT MTC LEGISLATION 1 

COMMITTEE AND ABAG LEGISLATION COMMITTEE 2 

FRIDAY, JULY 10, 2020 10:35 AM 3 

JAKE MACKENZIE, MTC CHAIR: I'M JAKE MACKENZIE MTC LEGISLATION 4 

COMMITTEE CHAIR AND I AM JOINED THIS AFTERNOON BY JULIE 5 

PIERCE.  6 

 7 

JULIE PIERCE, CHAIR ABAG: CHAIR OF THE ABAG LEGISLATION 8 

COMMITTEE.  9 

 10 

JAKE MACKENZIE, MTC CHAIR: THIS IS A JOINT MEETING OF BOTH 11 

COMMITTEES. I AM GOING TO ASK COUNCIL, DO I HAVE TO READ OUT 12 

THE NOTES TO ANNOUNCE AT THE OUTSET THAT HAVE ALREADY BEEN 13 

ANNOUNCED TODAY?  14 

 15 

SPEAKER: UNFORTUNATELY TO BE ON THE SAFE SIDE, YOU DO. DUE TO 16 

COVID-19, THIS MEETING WILL BE CONDUCTED AS A ZOOM WEBINAR. 17 

PURSUANT TO THE PROVISIONS OF THE GOVERNOR'S EXECUTIVE ORDER 18 

N-29-20, WHICH SUSPENDS CERTAIN REQUIREMENTS OF THE BROWN ACT. 19 

THIS MEETING WILL BE WEBCAST ON THE MTC WEB SITE. I WILL CALL 20 

UPON COMMISSIONERS, PRESENTERS, STAFF, AND OTHER SPEAKERS BY 21 

NAME AND ASK THAT THEY SPEAK CLEARLY AND RESTATE THEIR NAMES 22 

BEFORE GIVING COMMENTS OR REMARKS. PERSONS PARTICIPATING VIA 23 

ZOOM AND WEBCAST WITH THEIR CAMERAS ENABLED ARE REMINDED THEIR 24 

ACTIVITIES ARE VISIBLE TO VIEWERS. COMMISSIONERS AND MEMBERS 25 
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OF THE PUBLIC PARTICIPATING BY ZOOM, WISHING TO SPEAK SHOULD 1 

USE THE RAISED HAND FEATURE OR DIAL STAR NINE AND I WILL CALL 2 

UPON YOU AT THE APPROPRIATE TIME. TELECONFERENCE ATTENDEES 3 

WILL BE CALLED UPON BY THE LAST FOUR DIGITS OF THEIR PHONE 4 

NUMBERS. AND IT IS REQUESTED THAT PUBLIC SPEAKERS RESTATE 5 

THEIR NAMES AND ORGANIZATIONS, BUT PROVIDING SUCH INFORMATION 6 

IS VOLUNTARY. MEMBERS OF THE PUBLIC WISHING TO ADDRESS THIS 7 

BODY WERE ASKED TO SUBMIT COMMENTS IN WRITING AT 8 

INFO@BAYAREAMETRO.GOV. WRITTEN COMMENTS RECEIVED WILL BE 9 

POSTED TO THE ONLINE AGENDA AND ENTERED INTO THE RECORD BUT 10 

WILL NOT BE READ OUT LOUD. IF AUTHORS OF THE WRITTEN 11 

CORRESPONDENCE WOULD LIKE TO SPEAK, THEY ARE FREE TO DO ON THE 12 

REFERENCED AGENDA ITEM OR ANY TOPIC THEY CHOOSE. SPEAKERS 13 

SHOULD RAISE THEIR HAND, AND I WILL CALL UPON THEM AT THE 14 

APPROPRIATE TIME. A ROLL CALL VOTE WILL BE TAKEN FOR ALL 15 

ACTION ITEMS. THE CHAT FEATURE IS ACTIVE, HOWEVER, PLEASE BE 16 

AWARE THAT ANYTHING TYPED INTO THE CHAT WILL BE SUBJECT TO 17 

PUBLIC DISCLOSURE. THE CHAT FEATURE IS NOT AVAILABLE TO 18 

ATTENDEES. IN ORDER TO GET THE FULL ZOOM EXPERIENCE, PLEASE 19 

MAKE SURE YOUR APPLICATION IS UP TO DATE. AND NOW UNDER AGENDA 20 

ITEM NUMBER ONE, AS THE, GUESS I'M THE MASTER OF CEREMONIES 21 

HERE AND WORKING VERY CLOSELY WITH CHAIR PIERCE, AGENDA ITEM 22 

NUMBER ONE, ROLL CALL TO CONFIRM THE QUORUM, REQUEST PAY BACK, 23 

CLERK CALL THE ROLL, FIRST OF ALL.  24 

 25 
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CLERK OF THE BOARD: FOR THE ABAG LEGISLATION COMMITTEE MAYOR 1 

ARREGUIN?  2 

 3 

JESSE ARREGUIN: PRESENT.  4 

 5 

CLERK OF THE BOARD: SUPERVISOR CORTESE?  6 

 7 

DAVID CORTESE: HERE.  8 

 9 

CLERK OF THE BOARD: MAYOR PRO TEMPORE EKLUND?  10 

 11 

PAT EKLUND: HERE.  12 

 13 

CLERK OF THE BOARD: SUPERVISOR HAGGERTY?  14 

 15 

SCOTT HAGGERTY: PRESENT.  16 

 17 

CLERK OF THE BOARD: MAYOR HALLIDAY? HERE.  18 

 19 

CLERK OF THE BOARD: SUPERVISOR HUDSON?  20 

 21 

DAVID E. HUDSON: HERE.  22 

 23 

CLERK OF THE BOARD: SUPERVISOR MAR IS ABSENT. SUPERVISOR 24 

MITCHOFF?  25 
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 1 

KAREN MITCHOFF: HERE.  2 

 3 

CLERK OF THE BOARD: MAYOR PIERCE?  4 

 5 

JULIE PIERCE, CHAIR ABAG: HERE.  6 

 7 

CLERK OF THE BOARD: SUPERVISOR RABBIT?  8 

 9 

SUP. DAVID RABBIT: HERE.  10 

 11 

CLERK OF THE BOARD: SUPERVISOR RAMOS?  12 

 13 

BELIA RAMOS, VICE CHAIR ABAG: HERE.  14 

 15 

CLERK OF THE BOARD: QUORUM IS PRESENT.  16 

 17 

JAKE MACKENZIE, CHAIR MTC: CALL THE ROLL.  18 

 19 

CLERK OF THE BOARD: COMMISSIONER CONNOLY? SUPERVISOR CORTESE?  20 

 21 

DAVID CORTESE: HERE.  22 

 23 

CLERK OF THE BOARD: GIACOPINI, NON-VOTING.  24 

 25 
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DOREEN GIACOPINI: HERE.  1 

 2 

CLERK OF THE BOARD: LICCARDO? HERE.  3 

 4 

CLERK OF THE BOARD: COMMISSIONER MACKENZIE?  5 

 6 

JAKE MACKENZIE: HERE. COMMISSIONER RABBIT?  7 

 8 

SUP. DAVID RABBIT: HERE.  9 

 10 

CLERK OF THE BOARD: COMMISSIONER SLOCUM? COMMISSIONER SPERING?  11 

 12 

JAMES P. SPERING: PRESENT.  13 

 14 

CLERK OF THE BOARD: COMMISSIONER STRACNER, NOT VOTING. MTC HAS 15 

A QUORUM.  16 

 17 

JAKE MACKENZIE, MTC CHAIR: MOVES US TO AGENDA ITEM TWO LISTED 18 

ON THE AGENDA AS THE ABAG COMPENSATION ANNOUNCEMENT, CLERK OF 19 

THE BOARD SAYS LISTED ON THE AGENDA BUT NOT REQUIRED SO I 20 

WOULD DISPENSE WITH THAT, AND MOVE IMMEDIATELY TO AGENDA ITEM 21 

NUMBER THREE ABAG ITEM, ABAG LEGISLATION COMMITTEE CONSENT 22 

CALENDAR, HANDING IT OVER TO YOU CHAIR PIERCE.  23 

 24 
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JULIE PIERCE, CHAIR ABAG: THANK YOU CHAIR MACKENZIE. THIS ITEM 1 

IS THE ABAG LEGISLATION CONSENT CALENDAR. DO I HAVE ANYTHING 2 

ANYONE WISHES TO PULL OR A MOTION TO --  3 

 4 

DAVID E. HUDSON: MOVE HUDSON.  5 

 6 

KAREN MITCHOFF: SECOND.  7 

 8 

JULIE PIERCE, CHAIR ABAG: MOVED BY HUDSON SECOND BY MITCHOFF. 9 

ANY PUBLIC COMMENTS RECEIVED ON THIS ITEM?  10 

 11 

CLERK OF THE BOARD: NONE RECEIVED AND NO HANDS RAISED.  12 

 13 

JULIE PIERCE, CHAIR ABAG: WONDERFUL. ALL RIGHT. WITH THAT I 14 

WILL ASK YOU, FRED IF YOU WOULD PLEASE CALL THE ROLL. [ROLL 15 

CALL VOTE] MOTION PASSES. [ SILENCE ]  16 

 17 

JAKE MACKENZIE, MTC CHAIR: CONSENT CALENDAR.  18 

 19 

CLERK OF THE BOARD: ROLAND GO AHEAD.  20 

 21 

SPEAKER: THANK YOU. WANT TO ADDRESS YOUR ATTENTION TO ITEM 22 

EXTENSION OF A.B. 900 WHICH MADE IT POSSIBLE FOR THE GOOGLE IS 23 

APPLE SPACESHIP PROGRAM TO GET UPDATED. PROJECTS THAT COULD 24 

HELP US MOVING FORWARD WOULD BE THE SMART LARKSPUR FERRY 25 
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EXTENSION $50 MILLION. TRANSBAY $50 MILLION THAT WOULD BE 1 

CAPITAL CORRIDOR. DOWNTOWN EXTENSION, INCLUDING THE -- RAIL 2 

AVENUE NEW EXTENSION $1 BILLION, AND MOVING ON TO THE OTHER 3 

BILL, WHICH IS ITEM -- SENATE BILL 288 THAT BILL WOULD HELP US 4 

WITH DIRIDON STATION AND CAPITAL CORRIDOR REGIONAL CALTRAIN 5 

STATION. THANK YOU.  6 

 7 

JAKE MACKENZIE, MTC CHAIR: ARE THESE ALL THE RAISED HANDS 8 

MADAM CLERK?  9 

 10 

CLERK OF THE BOARD: YES ROLAND WAS THE ONLY ONE WITH HIS HAND 11 

RAISED.  12 

 13 

JAKE MACKENZIE, MTC CHAIR: PLEASE CONDUCT A ROLL CALL VOTE OF 14 

THE COMMITTEE MEMBERS OF THE MOTION THAT'S ON THE FLOOR.  15 

 16 

CLERK OF THE BOARD: [ROLL CALL VOTE] PASSES UNANIMOUSLY.  17 

 18 

JAKE MACKENZIE, MTC CHAIR: THANK YOU. BEFORE WE MOVE TO AGENDA 19 

ITEM 5A I WOULD LIKE REBECCA LONG IF SHE WOULD LET US KNOW THE 20 

STATE OF PLAY IN THE CALIFORNIA LEGISLATURE. AS SOME OF YOU OR 21 

MAYBE ALL OF US ARE WELL AWARE, THERE HAS BEEN A HIATUS 22 

DECLARED, REBECCA COULD YOU FILL US IN ON HOW YOU SEE THE 23 

CALENDAR PROCEEDING UP THERE IN SACRAMENTO?  24 

 25 
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REBECCA LONG: THANK YOU CHAIR MACKENZIE GOOD AFTERNOON 1 

EVERYONE. YES JUST BRIEFLY, THEY WERE SUPPOSED TO RECONVENE 2 

FROM SUMMER RECESS NEXT MONDAY BUT BOTH THE SPEAKER AND SENATE 3 

PRESIDENT CHRIS -- HAVE ANNOUNCED THAT WILL BE POST POSTPONED 4 

IN LIGHT OF THE RECENT SURGE IN COVID CASES AS WELL AS NOW SIX 5 

CONFIRMED CASES AMONG LAW MAKERS AND STAFF. THEY WERE GOING TO 6 

POTENTIALLY RETURN ON JULY 27TH BUT THEY HAVE TO RETURN TO GET 7 

BILLS THROUGH THE OFFICE AND TO THE GOVERNOR'S DESK IN AUGUST. 8 

THERE WILL BE A LIKELY DEADLINE WHERE IT WILL BE EXTENDED 9 

SOMEWHAT BUT THE DEADLINE TO GET THOSE THROUGH THE PROCESS THE 10 

GOVERNOR IS STILL PENDING. IS.  11 

 12 

JAKE MACKENZIE, MTC CHAIR: THANK YOU. APPRECIATE THAT. I 13 

THOUGHT IT WAS IMPORTANT THAT ALL MEMBERS OF BOTH COMMITTEES 14 

GET THIS INTELLIGENCE. THAT BRINGS US TO AGENDA ITEM 5A SENATE 15 

BILL 902 WIENER, HOUSING APPROVAL STREAMLINING TOOL, AND WE DO 16 

HAVE GEORGIA GANN DOHRMANN AS THE PRESENTER ON THIS ITEM.  17 

 18 

GEORGIA GANN DOHRMANN: GOOD AFTERNOON CHAIR MACKENZIE AND 19 

CHAIR PIERCE AND EVERYONE. I'M HOPING THAT WE CAN BRING UP THE 20 

SLIDES. THANK YOU. CAN YOU GO TO THE NEXT SLIDE PLEASE. GREAT. 21 

SO THIS IS THE FIRST OF OUR TWO ACTION ITEMS. STAFF IS 22 

RECOMMENDING SUPPORT ON SB 902, SENATOR WIENER'S BILL THAT 23 

WOULD PROVIDE A NEW AUTHORITY FOR LOCAL GOVERNMENTS TO ADOPT 24 

ORDINANCES. THEY WILL BE CEQA EXEMPT THAT WOULD ALLOW FOR THE 25 



               July 10, 2020 

 11 

CONSTRUCTION OF UP TO -- OF HOUSING PROJECTS UP TO TEN UNITS 1 

IN LOCATIONS THAT ARE CLOSE TO TRANSIT, JOBS, AND/OR THAT ARE 2 

INFILL LOCATIONS. IF YOU LOOK AT THE MAP ON THIS SLIDE, THIS 3 

IS AN EXAMPLE OF THE AREAS IN THE BAY AREA THAT WOULD BE 4 

ELIGIBLE FOR LOCAL GOVERNMENTS TO CHOOSE TO UTILIZE THIS 5 

PLANNING STREAMLINING TOOL. AND, AGAIN, THIS BILL IS NOW, IT'S 6 

A TOTALLY OPTIONAL THING FOR GOVERNMENTS TO CHOOSE TO DO. FLAG 7 

HERE IS THE BILL WAS SUBSTANTIALLY AMENDED IN THE SPRING TO 8 

REMOVE A PROVISION THAT WAS IN THE BILL AS INTRODUCED THAT 9 

WOULD HAVE REQUIRED LOCALITIES TO ALLOW BY RIGHT THE 10 

DEVELOPMENT OF SMALL MULTI-FAMILY HOUSING UNITS. AGAIN THAT 11 

PROVISION WAS REMOVED IN THE SPRING AND NOW IT IS STREAMLINED 12 

OR LIMITED TO THIS OPTIONAL HOUSING PRODUCTION TOOL. SO GIVEN 13 

THAT THIS COULD BE SOMETHING THAT COULD BE REALLY HELPFUL FOR 14 

LOCALITIES IN EXPEDITING HOUSING PRODUCTION AND REALLY ALWAYS 15 

IN MEETING OUR RHNA GOALS THAT ARE GOING TO BE PRETTY 16 

SUBSTANTIALLY LARGE, THIS TIME AROUND IN OUR UPCOMING HOUSING 17 

CYCLE, WE ARE RECOMMENDING SUPPORT ON THIS BILL.  18 

 19 

SAM LICCARDO, VICE CHAIR MTC: SO MOVED, LICCARDO.  20 

 21 

JAKE MACKENZIE, MTC CHAIR: DO I HAVE A SECOND?  22 

 23 

DAVID E. HUDSON: SECOND HUDSON. OR ARE YOU ON MTC?  24 

 25 
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JAKE MACKENZIE, MTC CHAIR: NO WE'RE -- WELL I'M, IN FACT, SAM, 1 

YOU KIND OF JUMPED --  2 

 3 

SAM LICCARDO, VICE CHAIR MTC: OH I WITHDRAW MY MOTION.  4 

 5 

JAKE MACKENZIE, MTC CHAIR: YEAH. I'M GOING ASK CHAIR PIERCE TO 6 

GIVE US A MINUTE HERE. I'M GOING TO ASK FIRST OF ALL, FOR 7 

COMMENTS THAT PEOPLE HAVE -- REQUEST -- NO ACTUALLY MORE 8 

APPROPRIATELY, QUESTIONS, THAT COMMISSIONERS AND DIRECTORS 9 

WOULD HAVE. SO, ARE THERE ANY SPECIFIC QUESTIONS AT THIS TIME 10 

OF GEORGIA? DO WE SEE ANY HANDS RAISED?  11 

 12 

PAT EKLUND: MY HAND.  13 

 14 

CLERK OF THE BOARD: PAT ECKLUND HAS HER HAND RAISED.  15 

 16 

JAKE MACKENZIE, MTC CHAIR: OKAY. CALLING ON EKLUND.  17 

 18 

CLERK OF THE BOARD: COMMITTEE MEMBER EKLUND, YOU CAN UNMUTE 19 

YOURSELF AGAIN?  20 

 21 

PAT EKLUND: OKAY THANKS. I HAVE ONE QUESTION FOR STAFF. CAN 22 

YOU HEAR ME?  23 

 24 

JAKE MACKENZIE, MTC CHAIR: YES.  25 
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 1 

CLERK OF THE BOARD: YES. WE CAN HEAR YOU.  2 

 3 

PAT EKLUND: OKAY. THANK YOU. GEORGIA, SECTION 65913.3A ALLOWS 4 

A CITY COUNCIL TO PASS AN ORDINANCE THAT WOULD BE ABLE TO 5 

OVERTURN AN ENACTED LOCAL VOTER INITIATIVE. IS THAT PROVISION 6 

STILL IN THERE? OR WAS THAT ELIMINATED DURING THE SPRING?  7 

 8 

GEORGIA GANN DOHRMANN: NO CORRECT. THAT PROVISION IS STILL IN 9 

THERE.  10 

 11 

PAT EKLUND: OKAY I'M NOT GOING TO BE ABLE TO SUPPORT THE BILL 12 

BECAUSE I DO NOT BELIEVE AT ALL CITY COUNCIL CAN OVERALL A 13 

VOTER INITIATED, OR A LOCAL VOTER INITIATIVE THAT PASSED BY 14 

THE ELECTORATE. SO PHILOSOPHICAL POSITION, AND I THINK 15 

OTHERWISE THE BILL, I WOULD SUPPORT IT. BUT I CANNOT SUPPORT 16 

IT WITH THAT PROVISION IN THERE.  17 

 18 

JAKE MACKENZIE, MTC CHAIR: OKAY. THANK YOU. ANY OTHER COMMENTS 19 

BEFORE WE GO TO PUBLIC COMMENTS? [ SILENCE ]  20 

 21 

SPEAKER: HI. THIS IS JOHN MINOT, CAN YOU HEAR ME?  22 

 23 

JAKE MACKENZIE, MTC CHAIR: YES.  24 

 25 
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SPEAKER: I AM A STEWARD -- RECOMMENDED FOR DECADES AS NEEDED 1 

FOR THE ENVIRONMENT IS FOR TRANSIT AFFORDABLE, THE CURRENT 2 

APPLICABILITY OF THE CALIFORNIA ENVIRONMENTAL AIR QUALITY ACT 3 

IS BUREAUCRACY MULTIPLE YEARS AND THOUSANDS OF DOLLARS. I URGE 4 

YOU TO GIVE THIS TO CITIES WHO WANT IT WHO HAVE ALREADY BUILT 5 

UP AREAS TO HELP CITIES MEET RHNA GOALS AND PROVIDE 6 

ALTERNATIVES TO GREENFIELD TRACT DEVELOPMENT. THANK YOU VERY 7 

MUCH.  8 

 9 

JAKE MACKENZIE, MTC CHAIR: THANK YOU FOR THOSE COMMENTS. 10 

ANYBODY ELSE?  11 

 12 

CLERK OF THE BOARD: NO OTHER MEMBERS OF THE PUBLIC WITH THEIR 13 

HAND RAISED.  14 

 15 

JAKE MACKENZIE, MTC CHAIR: HEARING NONE, I PASS THE FIGURATIVE 16 

GAVEL OVER TO CHAIR PIERCE.  17 

 18 

JULIE PIERCE, CHAIR ABAG: THANK YOU CHAIR MACKENZIE. IF THERE 19 

ARE NO FURTHER COMMENTS, DO I HAVE A MOTION?  20 

 21 

DAVID E. HUDSON: YOU ALREADY HAVE A MOTION. LICCARDO AND 22 

SECOND HUDSON. OR DID WE UNDO THAT?  23 

 24 

JULIE PIERCE, CHAIR ABAG: THOSE WERE MPC.  25 
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 1 

JAKE MACKENZIE, MTC CHAIR: WE WITHDREW.  2 

 3 

DAVID E. HUDSON: I'LL MAKE THE MOTION.  4 

 5 

JULIE PIERCE, CHAIR ABAG: WE HAVE A MOTION. SECOND BY 6 

HAGGERTY?  7 

 8 

KAREN MITCHOFF: MITCHOFF.  9 

 10 

JULIE PIERCE, CHAIR ABAG: OKAY. SECOND BY MITCHOFF. 11 

EVERYBODY'S TRYING TO GET IN. SORRY BELIA. [LAUGHTER]  12 

 13 

SCOTT HAGGERTY: NOT ME.  14 

 15 

JULIE PIERCE, CHAIR ABAG: ALL RIGHT, ALL IN FAVOR, FRED, 16 

PLEASE CALL THE ROLL.  17 

 18 

CLERK OF THE BOARD: [ROLL CALL VOTE]. MOTION PASSES.  19 

 20 

JULIE PIERCE, CHAIR ABAG: THANK YOU VERY MUCH. BACK TO YOU 21 

CHAIR MACKENZIE.  22 

 23 

JAKE MACKENZIE, MTC CHAIR: THANK YOU.  24 

 25 
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SPEAKER: SO MOVED --  1 

 2 

JAKE MACKENZIE, MTC CHAIR: LICCARDO MOVES. WHO SECONDED? I'M 3 

ANXIOUSLY AWAITING MTC'S SECOND.  4 

 5 

SPEAKER: SECOND.  6 

 7 

JAKE MACKENZIE, MTC CHAIR: THANK YOU. APPRECIATE THAT. I'LL 8 

ASK THE CLERK TO CONDUCT A ROLL CALL VOTE OF MTC COMMITTEE 9 

MEMBERS, PLEASE.  10 

 11 

CLERK OF THE BOARD: [ROLL CALL VOTE] PASSES UNANIMOUSLY.  12 

 13 

JAKE MACKENZIE, MTC CHAIR: THANK YOU. THAT CONCLUDES THAT 14 

ITEM. MOVES US TO AGENDA ITEM 5B. ASSEMBLY BILL 30402 MISSING 15 

MIDDLE HOUSING INCENTIVE. GEORGIA GANN DOHRMANN UP AGAIN.  16 

 17 

GEORGIA GANN DOHRMANN: GEORGIA GANN DOHRMANN, CAN WE HAVE THE 18 

NEXT SLIDE UP, PLEASE? NEXT SLIDE PLEASE. THANK YOU. SO STAFF 19 

IS AGAIN RECOMMENDING A SUPPORT POSITION ON A.B. 3040 20 

ASSEMBLYMEMBER CHIU INCENTIVE BILL THAT'S REALLY TARGETING 21 

WORKFORCE OR MIDDLE INCOME HOUSING. BILL IMPOSES CERTAIN INTO 22 

THE HOUSING ELEMENT PROCESS BY PROCURES THAT LOCALS WHO CHOOSE 23 

TO DENSIFY SINGLE FAMILY HOME SITES WILL RECEIVE RHNA CREDITS 24 

FOR THAT UPZONING. WE HAVE OUTLINED IN THIS, ON THE SLIDE, THE 25 
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SPECIFICS WE WANT TO CALL OUT THAT THE BILL PROVIDES A MINIMUM 1 

THAT FOR EVERY SINGLE FAMILY HOME THAT'S SITE UP ZONED TO 2 

ALLOW FOUR UNITS HCD WOULD BE REQUIRED TO PROVIDE A MINIMUM 3 

CREDIT OF .1 UNIT FOR EACH UPZONED SITE. SO AGAIN IT INSERTS 4 

UNCERTAINTY INTO THE HOUSING ELEMENT PROCESS THAT YOU WILL GET 5 

CREDITS UPZONING NON-VACANT LOTS. SLIDE AGAIN LISTS ALL OF THE 6 

DIFFERENT CONDITIONS AND LIMITATIONS ON THAT. ANOTHER NOTE, 7 

THAT I WANTED TO CALL OUT, IS THERE IS A DIFFERENCE IN THE 8 

SLIDE, AND WHAT IS IN OUR MEMO, BECAUSE THE BILL WAS AMENDED 9 

ON JULY 7TH TO RESPOND TO A LEAGUE OF CALIFORNIA CITIES AND 10 

THE CASAC REQUEST THAT THE SCOPE OF THE BILL REALLY BE 11 

EXPANDED TO ALLOW LOCALITIES TO RECEIVE RHNA CREDIT FOR 12 

UPZONINGS THAT, YOU KNOW, THEY MIGHT NOT HAVE HAD TO DO BY THE 13 

TIME A HOUSING ELEMENT WAS APPROVED THAT THEY GET THE RHNA 14 

CREDIT FOR UPZONING THAT IS IMPLEMENTED AS PART OF THAT 15 

HOUSING ELEMENT IMPLEMENTATION. SO THAT'S THE BIGGEST AND MOST 16 

SUBSTANTIVE AMENDMENT IN THE JULY 7TH CHANGE. SO GIVEN IT'S 17 

ANOTHER TOOL, WE -- THAT CAN HELP US MEET OUR RHNA GOALS, WE 18 

ARE SUPPORTING -- URGING A SUPPORT POSITION ON THIS BILL. 19 

THANKS.  20 

 21 

JAKE MACKENZIE, MTC CHAIR: THANK YOU. THIS WILL BE A TIME FOR 22 

ANY QUESTIONS TO BE ASKED OF STAFF BEFORE I MOVE TO PUBLIC 23 

COMMENTS.  24 

 25 
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JULIE PIERCE, CHAIR ABAG: MR. CHAIR, I ACTUALLY HAVE A 1 

QUESTION.  2 

 3 

JAKE MACKENZIE, MTC CHAIR: WELL THERE YOU GO MADAM CHAIR.  4 

 5 

JULIE PIERCE, CHAIR ABAG: MY QUESTION S DOES THE RHNA CREDIT 6 

GET AWARDED JUST ON THE REZONING WITHOUT ANY APPLICATION OR 7 

APPROVAL OF A PROJECT? REALLY? THEN I WANT THAT TO APPLY TO 8 

ALL MY REZONING. IS THEN GIVE ME MY RHNA CREDIT FOR ALL OF IT.  9 

 10 

GEORGIA GANN DOHRMANN: SO, WHEN I'M SAYING A RHNA CREDIT IT'S 11 

NOT FOR HOUSING PRODUCED. YOU CAN INCLUDE IN YOUR HOUSING 12 

ELEMENT SITE INVENTORY, SO YOU GET CREDIT FOR ACCOMMODATING 13 

RHNA.  14 

 15 

JULIE PIERCE, CHAIR ABAG: OH FOR PROVIDING A SITE. ALL RIGHT. 16 

NOT AN ACCOMPLISHMENT.  17 

 18 

GEORGIA GANN DOHRMANN: RIGHT.  19 

 20 

JULIE PIERCE, CHAIR ABAG: THANK YOU FOR THAT CLARIFICATION 21 

BECAUSE IT DOESN'T REALLY SAY THAT.  22 

 23 

JAKE MACKENZIE, MTC CHAIR: NICE TRY PIERCE. ANY OTHER 24 

QUESTIONS OF STAFF?  25 
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 1 

SAM LICCARDO, VICE CHAIR MTC: JAKE?  2 

 3 

JAKE MACKENZIE, MTC CHAIR: YES? I SEE DAVE.  4 

 5 

CLERK OF THE BOARD: COMMISSIONER LICCARDO IS UP FIRST.  6 

 7 

JAKE MACKENZIE, MTC CHAIR: OKAY SAM.  8 

 9 

SAM LICCARDO, VICE CHAIR MTC: THANK YOU CHAIR AND SAM. A 10 

COUPLE OF QUESTIONS, IN A BACKYARD HOME WHERE YOU HAVE THE 11 

STATEMENT PROPERTY OWNER PAYING PROPERTY TAX BUT THE OWNER 12 

STILL LIVING THERE DOES THAT COUNT FOR ADDITIONAL PURPOSES OF 13 

RHNA?  14 

 15 

GEORGIA GANN DOHRMANN: THAT IS UP TO HCD'S DISCRETION.  16 

 17 

SAM LICCARDO, VICE CHAIR MTC: OKAY. SO WE'RE NOT SURE. I GUESS 18 

-- AND THE OTHER QUESTION I HAD WAS AROUND THE 15 YEAR 19 

THRESHOLD, BECAUSE I WOULD IMAGINE THAT MOST HOMES BUILT IN 20 

2002 OR 1997, THERE IS ZERO CHANCE ANYONE IS GOING TO BULLDOZE 21 

THOSE HOMES TO ACTUALLY BUILD SOMETHING MORE DENSE, AND SO IT 22 

JUST SEEMS LIKE IT'S KIND OF PERFORMATIVE, BUT WON'T REALLY 23 

ACTUALLY RESULT IN MORE UNITS, UNLESS THE UNITS ARE QUITE A 24 

BIT OLDER, AND I'M WONDERING IS THERE ANY REASON WHY WE 25 
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WOULDN'T WANT TO LOBBY FOR AIR CHANGE IN THE AMENDMENT THAT 1 

WOULD SAY IT ONLY COUNTS IF YOU ARE TALKING ABOUT HOMES THAT 2 

ARE 30 YEARS OR OLDER?  3 

 4 

GEORGIA GANN DOHRMANN: GREAT QUESTION. CERTAINLY THAT 15 YEAR 5 

REQUIREMENT THAT SINGLE FAMILY HOME HAS ACTUALLY BEEN ON THE 6 

SITE FOR THAT LENGTH OF TIME IS INTENDED TO BE A GUARD RAIL 7 

FOR REALISTIC DEVELOPMENT POTENTIAL, AND WE'LL SEE THAT THE 8 

RHNA. [ SILENCE ] -- IT WOULD BE LIKELY THAT AT LEAST, OUT OF 9 

100 UPZONED SITES, TEN UNITS COULD GET BUILT. SO THAT'S WHY 10 

THE -- THAT'S WHY THERE IS THE .1 CREDIT PER UPZONED SITE.  11 

 12 

SAM LICCARDO, VICE CHAIR MTC: OKAY. AND IS THERE A REASON -- 13 

IS MY ASSUMPTION AN ACCURATE ONE BASED ON WHAT YOU SEE, THAT 14 

IS THAT GROWING -- WE'RE ONLY LIKELY TO SEE THIS IN MUCH OLDER 15 

HOMES?  16 

 17 

GEORGIA GANN DOHRMANN: I CAN'T SPEAK TO THAT IT'S VERY 18 

ACCURATE THAT WE'RE UNLIKELY TO SEE IT WITH VERY NEW HOMES BUT 19 

THERE'S NOTHING THAT SAYS THAT A HOMEOWNER THAT HAD A HOME 20 

BUILT IN 2002 WOULDN'T WANT TO SUBDIVIDE THEIR LOTS AND BUILD 21 

ANOTHER HOME THERE.  22 

 23 

SAM LICCARDO, VICE CHAIR MTC: OKAY. THANK YOU.  24 

 25 
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JAKE MACKENZIE, MTC CHAIR: THANK YOU. I THINK IT WAS DAVE 1 

HUDSON NEXT.  2 

 3 

DAVID E. HUDSON: THANK YOU JAKE. I THINK THE VERBIAGE THAT 4 

CONCERNS ME THE MOST, AND I'M NOT COMING OUT AGAINST THIS, 5 

IT'S A RED FLAG EVERY TIME I SEE IT, THE USE BY RIGHT. I CAN 6 

DEFINITELY SEE, IN NEW HOUSING, BECAUSE A FOURPLEX, 7 

THEORETICALLY IS GOING TO MAKE MORE MONEY THAN BUILDING A 8 

SIMPLE 16E17nd SQUARE FOOT HOME AND THEN I START WORRYING 9 

ABOUT THE OTHER LAWS THAT WE HAVE LIKE GROUP HOMES ET CETERA 10 

EACH ONE OF THESE PEOPLE PUT SEVEN OR 14 PEOPLE IN EACH UNIT 11 

IT'S THE USE BY RIGHT INSTEAD OF BUILD BY RIGHT I THINK I'M 12 

CONCERNED ABOUT, HAS THERE BEEN ANY DISCUSSION ABOUT THIS OR 13 

PUSH BACK THAT YOU KNOW OF WHEN THIS WAS GOING THROUGH THE 14 

LEGISLATION? OR IT'S JUST, YOU ZONE IT, AND THEN WHEN IT COMES 15 

IN, YOU KIND OF GET IT -- A LITTLE BIT OF HISTORY, THE THING 16 

THAT GOT ME INTO POLITICS 30 YEARS AGO IS THE GOLF COURSE 17 

WANTED TO BUILD THREE OF THESE UNITS ON SEPARATE PARCELS THAT 18 

REALLY WASN'T PART OF THEIR GOLF COURSE AND LET'S JUST SAY WE 19 

CAME OUT OF THE WOOD WORKS. ANY PUSH BACK ON THIS GEORGIA?  20 

 21 

GEORGIA GANN DOHRMANN: I HAVE NOT HEARD BUSH BACK ON THE 22 

TERMINOLOGY OF USE BY RIDE INSTEAD OF BUILD BY RIGHT, THIS 23 

WOULD BE LOCALITY TO UPZONE SITES IN EXCHANGE OF RHNA CREDITS 24 

SO IT WOULD BE UP TO THE LOCALITY BUT I THINK USE BY RIGHT IS 25 
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REALLY CONSISTENT LANGUAGE USED THROUGHOUT HOUSING ELEMENT 1 

LAW, SO I THINK THAT'S WHY THERE'S THAT TERMINOLOGY THERE. 2 

IT'S FOR CONSISTENCY. AND THEN CHAIR MACKENZIE AND PIERCE, I 3 

FORGOT TO REQUEST THAT WE EXERCISE OUR URGENCY PROCEDURE TO -- 4 

BECAUSE OF THE TIMING OF THIS, IT'S TIME SENSITIVE SO THAT 5 

WOULD BE AN ADDITIONAL STAFF RECOMMENDATION IS TO EXERCISE OUR 6 

URGENCY PROCEDURE.  7 

 8 

JAKE MACKENZIE, MTC CHAIR: SO LET ME BE CLEAR. WHEN A MOTION 9 

IS MADE BY BOTH BODIES HERE, THAT IT WOULD INCLUDE THE, WHAT 10 

YOU JUST STATED, THAT IT WOULD BE CONSIDERED AS AN URGENCY 11 

ACTION ON THE PART OF BOTH COMMITTEES? AM I GETTING THAT 12 

RIGHT?  13 

 14 

GEORGIA GANN DOHRMANN: CORRECT.  15 

 16 

JAKE MACKENZIE, CHAIR MTC: OKAY. I WANT EVERYBODY -- CERTAINLY 17 

ON MY COMMITTEE, AND I AM SURE CHAIR PIERCE DOES ON HERS TO 18 

UNDERSTAND THAT, SO WE CAN MOVE FORWARD.  19 

 20 

JULIE PIERCE, CHAIR ABAG: JAKE, I'M NOT SURE WHETHER MTC IS 21 

ACTUALLY ADOPTED AN URGENCY PROVISION YET. I KNOW THAT ABAG 22 

HAS. HAS MTC NOW DONE THAT?  23 

 24 
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SPEAKER: WE HAVE HAD ONE IN OUR COMMISSION PROCEDURES FOR 1 

SOMETIME.  2 

 3 

SCOTT HAGGERTY: DO YOU KNOW WHAT IT IS?  4 

 5 

ADRIENNE WEIL, COUNSEL: IT'S APPENDIX F.  6 

 7 

JAKE MACKENZIE, MTC CHAIR: THANK YOU. ANY FURTHER QUESTIONS BY 8 

ANYBODY ON THE COMMITTEES?  9 

 10 

CLERK OF THE BOARD: COMMITTEE MEMBER HALLIDAY HAS HER HAND 11 

RAISED.  12 

 13 

JAKE MACKENZIE, MTC CHAIR: SORRY.  14 

 15 

SCOTT HAGGERTY: I'M TRYING TO ASK A QUESTION TOO JAKE.  16 

 17 

BARBARA HALLIDAY: I'M NOT SURE I'M UNDERSTANDING, YOU GET 18 

CREDIT IF YOU DO THE HOUSING BUT ALSO GET CREDIT IF HOUSING 19 

WAS BUILT IN YOUR RHNA NUMBERS, I GUESS THAT WAS MY QUESTION. 20 

SO YOU GET CREDIT AT FIRST FOR JUST HAVING -- AND IT'S ONE 21 

10th FOR EACH ONE ON THE ASSUMPTION THAT TEN -- THAT'S WHAT I 22 

DON'T WANT -- I DON'T UNDERSTAND IS ONE 10th FOR THE CREDIT 23 

AND THE OTHER QUESTION IS, I UNDERSTAND THAT'S FOR THE 24 

REZONING, THE OTHER PART OF IT IS WHEN HOUSING GETS BUILT YOU 25 
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ALSO GET CREDIT FOR THOSE HOMES DEPENDING ON WHAT LEVEL INCOME 1 

THEY MEET, RIGHT?  2 

 3 

GEORGIA GANN DOHRMANN: CORRECT. LET ME TRY TO TAKE A STEP 4 

BACK. SO THIS BILL WOULD ALLOW THAT WHEN YOU'RE PUTTING 5 

TOGETHER YOUR SITE INVENTORY TO DEMONSTRATE THAT YOU HAVE 6 

ACCOMMODATED RHNA, YOUR RHNA THRESHOLDS FOR MODERATE, ABOVE 7 

MODERATE AND LOW INCOME HOUSING, YOU WOULD BE ABLE TO INCLUDE 8 

ON A NON-VACANT SITE WHICH IS NORMALLY CHALLENGING TO CREATE 9 

CREDIT ON INVENTORY FOR NON-VACANT SITE HCD HAS TO AT MINIMUM 10 

PROVIDE YOU .1 PERCENT CREDIT TOWARDS MODERATE OR ABOVE 11 

MODERATE INCOME, YOU KNOW, RHNA, ACCOMMODATING THOSE HOUSING 12 

UNITS ON YOUR SITE'S INVENTORY. AND IF YOU -- IF LATER, AFTER 13 

YOU REZONED AND HOUSING ELEMENT HAS BEEN APPROVED THEN A 14 

HOUSING UNIT WAS BUILT THERE YOU WOULD RECEIVE CREDIT FOR 15 

ACTUALLY HAVING THE HOUSING UNIT DELIVERED.  16 

 17 

BARBARA HALLIDAY: OKAY THANKS.  18 

 19 

JAKE MACKENZIE, MTC CHAIR: OKAY AND DID I HEAR ANYONE ELSE?  20 

 21 

SCOTT HAGGERTY: YES YOU DID, MR. CHAIR.  22 

 23 

JAKE MACKENZIE, MTC CHAIR: SOUND LIKE THE CHAIR.  24 

 25 
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SCOTT HAGGERTY: THANK YOU. I'M TRYING TO UNDERSTAND WHAT MTC'S 1 

EMERGENCY PROVISIONS ARE. I KNOW WHAT ABAG'S ARE.  2 

 3 

JAKE MACKENZIE, MTC CHAIR: COUNCILMEMBER WEIL?  4 

 5 

ADRIENNE WEIL, COUNSEL: WE HAVE A PROVISION IN THE COMMISSION 6 

MEMBERS MANUAL THAT SAYS IF THE COMMITTEE WANTS TO TAKE A 7 

POSITION AND IT NEEDS TO BE COMMUNICATED TO THE LEGISLATURE 8 

BEFORE THE FULL COMMISSION HAS ITS MEETING TO, YOU KNOW, TAKE 9 

THE FINAL ACTION ON THAT POSITION, THAT IN AN EMERGENCY 10 

PROCEDURE ALLOWS THE CHAIR OF THE LEGISLATION COMMITTEE WITH 11 

CONCURRENCE OF THE CHAIR OF THE COMMISSION TO HAVE THE 12 

POSITION BROUGHT TO THE ATTENTION OF THE LEGISLATURE BEFORE 13 

THE FINAL ACTION OCCURS AT THE COMMISSION MEETING. AND 14 

USUALLY, THIS IS MADE PART OF THE MOTION WHEN YOU TAKE YOUR 15 

ACTION AT THE COMMITTEE LEVEL.  16 

 17 

JAKE MACKENZIE, MTC CHAIR: THANK YOU FOR THAT CLARIFICATION. 18 

IS THAT CLEAR TO THE CHAIR OF THE COMMISSION? MR. HAGGERTY?  19 

 20 

SCOTT HAGGERTY: SO FAR, MR. CHAIR.  21 

 22 

JAKE MACKENZIE, MTC CHAIR: OKAY. LET US PROCEED THEN TO PUBLIC 23 

COMMENT IF WE HAVE ANY. EITHER OF THE WRITTEN OR THE RAISED 24 

HAND, OR THE PHONE IN KIND.  25 
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 1 

CLERK OF THE BOARD: THERE IS NO PUBLIC COMMENT SUBMITTED 2 

SUBMITTED ON THIS ITEM. AND THERE IS ONE MEMBER OF THE PUBLIC 3 

WITH THEIR HAND RAISED. GO AHEAD.  4 

 5 

SPEAKER: HI. THIS IS JOHN M. WE HAVE ENDORSED THIS. URGE YOUR 6 

SUPPORT, AND I THINK YOU CAN SEE HOW THIS INTERLOCKS WELL WITH 7 

SB 902. THANK YOU.  8 

 9 

JAKE MACKENZIE, MTC CHAIR: THANK YOU VERY MUCH. DOES THAT 10 

CONCLUDE PUBLIC COMMENT?  11 

 12 

CLERK OF THE BOARD: THAT CONCLUDES PUBLIC COMMENT.  13 

 14 

JAKE MACKENZIE, MTC CHAIR: THANK YOU VERY MUCH. NOW, I TURN 15 

THIS OVER TO CHAIR PIERCE.  16 

 17 

JULIE PIERCE, CHAIR ABAG: THANK YOU MR. CHAIR. DO I HAVE A 18 

MOTION FROM ANY OF THE ABAG MEMBERS ON THIS ITEM?  19 

 20 

BARBARA HALLIDAY: I WILL MOVE IT.  21 

 22 

JULIE PIERCE, CHAIR ABAG: THANK YOU BARBARA. MOTION BY 23 

HALLIDAY. SECOND?  24 

 25 
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JESSE ARREGUIN: SECOND.  1 

 2 

JULIE PIERCE, CHAIR ABAG: SECOND BY ARREGUIN.  3 

 4 

JULIE PIERCE, CHAIR ABAG: FRED COULD YOU CALL THE ROLL.  5 

 6 

CLERK OF THE BOARD: IF I CAN CLARIFY.  7 

 8 

JULIE PIERCE, CHAIR ABAG: I HEARD IN THE MOTION VERY CLEARLY 9 

BARBARA SAID IT WAS UNDER THE URGENCY PROVISION.  10 

 11 

BARBARA HALLIDAY: THAT WAS MY TOTAL INTENT.  12 

 13 

JAKE MACKENZIE, MTC CHAIR: WELL DONE BARBARA. [LAUGHTER]  14 

 15 

CLERK OF THE BOARD: ON THE ABAG MOTION. [ROLL CALL VOTE]. 16 

MOTION PASSES, SEVEN VOTES.  17 

 18 

JAKE MACKENZIE, MTC CHAIR: THANK YOU VERY MUCH CHAIR PIERCE. 19 

I'M GOING TO ASK IF I HAVE A MOTION AND A SECOND TO REFER A 20 

SUPPORT POSITION AND ALSO TO UTILIZE THE EMERGENCY PROCEDURES 21 

ENUNCIATED BAY OUR COUNSEL WHICH AUTHORIZES THE LEGISLATE YOU 22 

COMMITTEE CHAIR AND THE CHAIR OF THE COMMISSION TO ALSO 23 

APPROVE SENDING THIS MESSAGE OF SUPPORT FORWARD TO THE 24 

LEGISLATURE PRIOR TO A FULL COMMISSION MEETING AND SO THAT 25 
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WOULD BE THE MOTION. AND DO I HAVE A MOTION AND A SECOND, 1 

PLEASE, FROM MTC?  2 

 3 

JAMES P. SPERING: SPERING WILL MOVE IT.  4 

 5 

JAKE MACKENZIE, MTC CHAIR: OKAY. AND WHO WILL SECOND? I'M 6 

SECOND IT TO MOVE THIS FORWARD.  7 

 8 

SAM LICCARDO, VICE CHAIR MTC: CHAIR, I WANT TO ASK FOR A 9 

FRIENDLY AMENDMENT IF POSSIBLE.  10 

 11 

JAKE MACKENZIE, MTC CHAIR: GO AHEAD. YEAH.  12 

 13 

SAM LICCARDO, VICE CHAIR MTC: FOR COMMISSIONER SPERING, WHAT 14 

I'M CONCERNED ABOUT THIS IS IT COULD BE USED ESSENTIALLY BY 15 

JURISDICTIONS TO GIVE RHNA CREDITS WITHOUT ANY REAL INTENTION 16 

OF GETTING THIS HOUSING BUILT, PARTICULARLY IF YOU'RE LOOKING 17 

AT PRETTY NEW HOUSING STOCK SO I WOULD BE HAPPY TO SUPPORT, 18 

BUT I REQUEST THAT A -- SOME AMENDMENT TO EITHER REQUIRE THAT 19 

THE HOUSING BE OLDER STOCK OR THAT THERE BE SOME OTHER 20 

REQUIREMENT OF MORE SUBSTANTIAL ACTION. -- TO REPAIR A HOUSE 21 

AT THAT AGE.  22 

 23 

JAKE MACKENZIE, MTC CHAIR: REBECCA LONG, I RECOGNIZE YOU, 24 

PLEASE.  25 
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 1 

REBECCA LONG: THANK YOU CHAIR MACKENZIE. COMMISSIONER 2 

LICCARDO, I WANT TO CLARIFY IF WE DO TRY TO GET SOME 3 

AMENDMENTS ALONG THESE LINES, IN THIS SORT OF FRIENDLY 4 

AMENDMENT WHERE WE WOULD INDICATE OUR SUPPORT BUT SUGGEST THAT 5 

WOULD BE SOMETHING THEY LOOK AT BECAUSE WE ARE MINDFUL OF THE 6 

TIMELINE THAT IT'S SO COMPRESSED AND I WANT TO REITERATE THAT 7 

ONE OF THE THINGS THAT MAKES IT MORE LIKELY THAT SUCH HOUSE 8 

GETS BUILT IS THERE IS A BY RIGHT TO THIS. IT'S THE 9 

JURISDICTION REZONES BUT EVERYTHING IS SUBJECT TO JURISDICTION 10 

APPROVAL THEY WOULD NOT QUALIFY TO THE CREDIT.  11 

 12 

SAM LICCARDO, VICE CHAIR MTC: POINT WELL TAKEN AND YES IT 13 

WOULD BE A FRIENDLY.  14 

 15 

JAMES P. SPERING: I'LL ADD TO THE MOTION THAT THEY CONSIDER 16 

OLDER HOMES AND I DON'T KNOW WHAT THE YEAR IS, 25 OR 30, BUT 17 

THE FRIENDLY AMENDMENT EMPHASIZING OLDER HOMES.  18 

 19 

JAKE MACKENZIE, MTC CHAIR: BACK TO STAFF, IS THAT WORKABLE? 20 

OKAY. SO WE HAVE THE AMENDED MOTION, FRIENDLY AMENDMENT TO THE 21 

MOTION, WHICH HAS BEEN ACCEPTED BY THE MAKER OF THE MOTION, 22 

AND THE SECONDER OF THE MOTION, I WOULD ASK FOR A ROLL CALL 23 

VOTE, PLEASE.  24 

 25 
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CLERK OF THE BOARD: [ROLL CALL VOTE]. WE DON'T HAVE A QUORUM. 1 

COMMISSIONER RABBIT STEPPED AWAY, SO WE'LL NEED TO DEPUTIZE --  2 

 3 

SCOTT HAGGERTY: COMMISSIONER HAGGERTY VOTES YES.  4 

 5 

CLERK OF THE BOARD: THANK YOU.  6 

 7 

JAKE MACKENZIE, MTC CHAIR: [LAUGHTER] VERY GOOD HAGGERTY, YOU 8 

POPPED UP FROM NOWHERE AND YOU'RE DEPUTIZED.  9 

 10 

SCOTT HAGGERTY: AT LEAST I'M PAYING ATTENTION.  11 

 12 

JAKE MACKENZIE, MTC CHAIR: YOU ARE PAYING ATTENTION AND YOU 13 

ARE DEPUTIZED AND WE DO HAVE A QUORUM. THANK YOU. THAT BEING 14 

SAID, THAT BRINGS US TO AGENDA ITEM NUMBER SIX, PUBLIC 15 

COMMENT, ANY OTHER BUSINESS? ANY OTHER BUSINESS FROM ANYBODY 16 

ON EITHER SIDE OF THE AISLE? ANY PUBLIC COMMENT MADAM CLERK?  17 

 18 

CLERK OF THE BOARD: NO PUBLIC COMMENT WAS SUBMITTED ON THIS 19 

ITEM. THERE IS ONE MEMBER OF THE PUBLIC WITH THEIR HAND 20 

RAISED. ROBERT, GO AHEAD AND UNMUTE YOURSELF.  21 

 22 

SPEAKER: HI GOOD AFTERNOON COMMITTEE MEMBERS ROBERT F FROM SAN 23 

FRANCISCO. I MISSED THE LAST COMMENT BUT I WANT TO COMMENT ON 24 

ZONE CAPACITY FOR PURCHASES OF RHNA I DELVED INTO SAN 25 
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FRANCISCO HOUSING CAPACITY BETWEEN -- IN THE LAST CENTURY, AND 1 

WHAT I HAVE FOUND, I FOUND THAT ZONE CAPACITY MATTERS A GREAT 2 

DEAL. IN THE 1940s, SAN FRANCISCO WAS ABOUT -- HAD HALF OF ITS 3 

RESIDENTIAL LAND ZONED FOR MULTI-FAMILY HOUSING, BUT BY NOW -- 4 

BY THIS TIME, AROUND 70 TO 75 PERCENT OF OUR ZONED CAPACITY IS 5 

SINGLE FAMILY ZONING ONLY, AND THAT CAPACITY MAKES THE 6 

DIFFERENCE BETWEEN POPULATION LIMIT OF AROUND 165,900,000. AND 7 

-- 165,000 AND THAT 900,000 AND THAT MAKES AN ADVERSE IN OUR 8 

CAPACITY AND SAN FRANCISCO SAID WE'RE REACHING CAPACITY WE 9 

WANT TO KEEP OUR RESIDENTIAL NEIGHBORHOODS BUT LET'S ADDRESS 10 

OUR RESIDENTIAL NEIGHBORS AND THAT'S AFFECT THE EQUITY. I WANT 11 

TO PASS ZONING AS HAVING A MARRIAGE EFFECT -- MAJOR EFFECT ON 12 

POPULATION.  13 

 14 

JAKE MACKENZIE, MTC CHAIR: THANK YOU VERY MUCH. DOES THAT END 15 

PUBLIC COMMENT ON AGENDA ITEM NUMBER SIX?  16 

 17 

CLERK OF THE BOARD: THERE ARE NO OTHER MEMBERS OF THE PUBLIC 18 

WITH THEIR HANDS RAISED.  19 

 20 

JAKE MACKENZIE, MTC CHAIR: LOVING THE DOG IN THE BACKGROUND. 21 

BEFORE WE ADJOURNED, I WOULD LIKE TO THANK CHAIR PIERCE AS 22 

ALWAYS HELPING TO CONDUCT THIS JOINT MEETING OF THESE TWO 23 

COMMITTEES. I WOULD LIKE TO THANK STAFF PARTICULARLY FOR 24 

HANGING IN THERE, AND FOR THEIR ANALYSIS AND COMMENTS. I WOULD 25 



               July 10, 2020 

 32 

LIKE TO THANK ALL OF YOU GUYS FOR HANGING IN THERE. THIS HAS 1 

BEEN YET ANOTHER MARATHON. WE KEEP ON BREAKING RECORDS.  2 

 3 

SCOTT HAGGERTY: MR. CHAIR.  4 

 5 

JAKE MACKENZIE, MTC CHAIR: -- FOR OUR ZOOM COMMITTEE MEETINGS. 6 

MR. CHAIR HAGGERTY THANK YOU VERY MUCH AS WELL FOR HANGING IN 7 

THERE.  8 

 9 

SCOTT HAGGERTY: I HAVE A QUESTION.  10 

 11 

JAKE MACKENZIE, MTC CHAIR: YOU DO. ME?  12 

 13 

SCOTT HAGGERTY: MAYBE I WASN'T PAYING ATTENTION AS MUCH AS I 14 

THOUGHT.  15 

 16 

JAKE MACKENZIE, MTC CHAIR: [LAUGHTER]  17 

 18 

SCOTT HAGGERTY: ON THE LAST ITEM, DO WE HAVE TWO DIFFERENT 19 

MOTIONS ONE WITH AN AMENDMENT AND ONE WITHOUT THE AMENDMENT?  20 

 21 

JAKE MACKENZIE, MTC CHAIR: WE HAVE AN ABAG MOTION. BUT IT'S 22 

SEPARATE --  23 

 24 

JULIE PIERCE, CHAIR ABAG: THE MTC MOTION IN HAD AN AMENDMENT.  25 
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 1 

SCOTT HAGGERTY: I GET IT, SHOULD WE TRY TO, TO MAKE IT EASIER 2 

ON STAFF, SHOULD WE TRY TO SEE IF ABAG CAN AT LEAST SUPPORT 3 

THAT?  4 

 5 

JULIE PIERCE, CHAIR ABAG: I WOULD SUGGEST THAT RATHER THAN 6 

REQUESTING A FORMAL AMENDMENT MAYBE WHAT WE DO IS MAKE A 7 

SUGGESTION THEY CLARIFY THE AGE OF HOMES THEY WANT THIS TO 8 

APPLY TO. BECAUSE THERE MAY BE SOME THAT HAVE BEEN BUILT IN 9 

THE LAST TEN YEARS FRANKLY THAT YOU CAN ADD AN ADU TO, WITHOUT 10 

ANY PROBLEM IN THE NEIGHBORHOOD IT JUST DEPENDS ON THE SIZE OF 11 

THE LOT.  12 

 13 

SCOTT HAGGERTY: I'M FINE I'M JUST TRYING TO MAKE IT EASIER ON 14 

STAFF.  15 

 16 

JAKE MACKENZIE, MTC CHAIR: I WAS GOING ASK STAFF, MR. CHAIR, 17 

IF IT'S CAPABLE OF ADDING THE LEGISLATURE TO MOTIONS.  18 

 19 

REBECCA LONG: I DON'T THINK IT'S A PROBLEM PARTICULARLY AS I 20 

UNDERSTAND THE MOTION IT WAS SUPPORT AND SEEK AMENDMENT FROM 21 

MTC SO IT'S NOT LIKE THEY'RE IN CONFLICT IN PARTICULAR. BUT 22 

THANK YOU FOR THE QUESTION CHAIR HAGGERTY.  23 

 24 
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SCOTT HAGGERTY: YEAH, BUT, I MEAN, I THINK PROCEDURALLY, THIS 1 

IS SOMETHING THAT -- AND MAYBE IT'S A VIEW POINT AS WE GET 2 

CLOSER TO MERGING THE TWO COMMITTEES, BUT IF ABAG DOESN'T LIKE 3 

IT AND WE KIND OF GO UNDER THIS THEORY THAT WELL, WE'LL JUST 4 

MAKE IT WORK, THEN IT BECOMES A PROBLEM. BECAUSE ABAG IS A 5 

HOUSING -- YOU SEE WHAT I'M SAYING? THIS --  6 

 7 

JULIE PIERCE, CHAIR ABAG: CAN I ASK A QUESTION OF THE ABAG 8 

MEMBERS. DOES ANYBODY HAVE A PROBLEM WITH THE SUGGESTED 9 

AMENDMENT THAT MTC ADOPTED?  10 

 11 

PAT EKLUND: THIS IS PAT. I DO. BECAUSE IT RESTRICTS OUR 12 

FLEXIBILITY. UNLESS THE DEFINITION OF OLD. I LIKE YOUR 13 

EXPLANATION EARLIER, THAT DIFFERENT COMMUNITIES HAVE DIFFERENT 14 

CIRCUMSTANCES. AND I -- THE WHOLE REASON I SUPPORTED THIS BILL 15 

IS BECAUSE IT GAVE US SOME FLEXIBILITY, AND IT WAS NOT 16 

PRESCRIPTIVE, AND NOW IF WE'RE TRYING TO MAKE IT PRESCRIPTIVE 17 

BY ONLY ELIMINATING IT TO OLDER HOMES, I'M NOT SURE I WOULD 18 

SUPPORT IT THEN BECAUSE THAT MAY ELIMINATE SOME OF THE 19 

FLEXIBILITY THAT WE NEED IN OUR HOUSING ELEMENT.  20 

 21 

JAKE MACKENZIE, MTC CHAIR: AND HERE I THOUGHT I WAS JUST 22 

TRYING TO ADJOURN THE MEETING. BUT NEVER MIND. [LAUGHTER] 23 

ANYWAY.  24 

 25 
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JULIE PIERCE, CHAIR ABAG: STAFF, DO YOU HAVE A RECOMMENDATION 1 

ON THIS? I THINK YOU'RE OKAY WITH GOING FORWARD WITH IT, AS IT 2 

WAS STATED. IS THAT WHAT I'M HEARING?  3 

 4 

REBECCA LONG: YEAH. THAT'S WHAT I SAID. I THINK THAT MAYBE 5 

WHAT WE CAN DO IS DO SOME MORE RESEARCH. GEORGIA MENTIONED 6 

THERE HAD BEEN SOME RESEARCH DONE TO LOOK INTO THE FEASIBILITY 7 

AND INFORMED THE MATH, RIGHT, THE TEN PERCENT RATIO, FOR WHAT 8 

THE CREDIT IS, AND WE'LL CERTAINLY RAISE IT, YOU KNOW, AS 9 

SOMETHING THAT WE WANTED TO LOOK AT. IF THE POSITION IS MTC 10 

SUPPORTS IT, IS INTERESTED IN POTENTIALLY AMENDING IT AND ABAG 11 

SUPPORTS IT OUTRIGHT I DON'T THINK WE'RE IN TOO MUCH OF AN 12 

AWKWARD SPACE.  13 

 14 

JAKE MACKENZIE, MTC CHAIR: AND I WOULD THANK MAYOR LICCARDO 15 

FOR BRINGING THIS UP. AND I DO BELIEVE THAT WE CAN RELY ON OUR 16 

STAFF. THEY'LL FIGURE OUT HOW TO COMMUNICATE THE NUANCES OF 17 

THE DISCUSSION WE HAVE HAD THIS AFTERNOON. I DO BELIEVE. THAT 18 

BEING SAID, I'M GOING TO STAFF THANKING ANYBODY ANYMORE, AND 19 

ADJOURN THIS MEETING UNTIL FRIDAY SEPTEMBER 11TH AT 9:40 A.M., 20 

OR REMOTELY, OR BY WEBCAST, OR BY WHICHEVER WAY WE'RE 21 

COMMUNICATING, IN SEPTEMBER. OKAY. WE'RE DONE. [ADJOURNED]  22 

 23 


